Teamcenter 10.1

Getting Started with Document Management
Proprietary and restricted rights notice

This software and related documentation are proprietary to Siemens Product Lifecycle Management Software Inc.

© 2013 Siemens Product Lifecycle Management Software Inc. All Rights Reserved.

Siemens and the Siemens logo are registered trademarks of Siemens AG. Teamcenter is a trademark or registered trademark of Siemens Product Lifecycle Management Software Inc. or its subsidiaries in the United States and in other countries. All other trademarks, registered trademarks, or service marks belong to their respective holders.
Contents

Proprietary and restricted rights notice ........................................... 2
Introduction to document management ............................................. 1-1
Document management functionality ............................................. 1-1
Before you begin ............................................................................. 1-2
Basic concepts of document management ....................................... 2-1
Document management overview ................................................... 2-1
Document management basics ....................................................... 2-1
Document management examples ................................................... 2-4
Installing and configuring document management ......................... 3-1
Installing and configuring document management ......................... 3-1
Document management prerequisites ............................................. 3-1
Installing document management components .............................. 3-3
Configuring full-text search ......................................................... 3-4
Using the Business Modeler IDE to configure document management ........................................... 3-4
Using style sheets ........................................................................... 3-5
Rendering documents ...................................................................... 3-6
Rendering thumbnail graphics ....................................................... 3-9
Configuring batch printing ............................................................. 3-11
Markup capabilities in Teamcenter .................................................. 3-20
Configuring document markup ...................................................... 3-21
Access privileges and preferences for digital signing ....................... 3-23
Import a sample document management template file ..................... 3-25
Basic tasks for document management .......................................... 4-1
Basic user tasks for document management .................................... 4-1
Creating document templates ....................................................... 4-1
Creating documents ........................................................................ 4-1
Generating thumbnail graphics ...................................................... 4-2
Using full-text searches ................................................................. 4-4
Using document management batch printing .................................. 4-5
Configuring view and markup functionality .................................... 4-7
Workflow and document management ........................................... 4-8
Change management and document management ........................... 4-9
Document management in Teamcenter clients ............................... 5-1
Document management in Teamcenter clients ................................ 5-1
Rich client document management ............................................... 5-1
Thin client document management ............................................... 5-1
Teamcenter Client for Microsoft Office and document management ........................................... 5-2
Contents

Glossary ................................................................. A-1
Index ................................................................. Index-1
Chapter

1 Introduction to document management

Document management functionality ........................................ 1-1
Before you begin ..................................................................... 1-2
Chapter

1 Introduction to document management

Document management functionality

Document management functionality in Teamcenter provides the capability to manage documents created by other software applications, such as office software, CAD software, and so on, and to render presentation (view-only) versions, manage markups, and define print and system stamp configurations.

- Document management uses item revision definition configuration (IRDC) objects, defined in the Business Modeler IDE application, to:
  - Automate document rendering.
  - Enhance workflow.
  - Provide batch print capabilities, including banner and stamp functionality.
  - Support document view and markup.
  - Manage automated document storage and availability based on business processes.
  - Simplify end-user interactions with Teamcenter documents, reducing the level of understanding end users must have of the Teamcenter data model and relationship model.

- Content Management is an optional Teamcenter solution, separate from the document management functionality, that provides a single source publishing system for the creation of technical documentation comprised of SGML and XML content components and associated graphics stored in a Teamcenter database. Content developed as individual components can be reused among different publications.

  For more information about structured content authoring and publishing using XML and SGML, see the Content Management Guide.

- Teamcenter Client for Microsoft Office (Client for Office) lets you to create and manage Teamcenter documents in Microsoft Word, Microsoft Excel, or Microsoft PowerPoint.

  For information about using document management in Client for Office, see Teamcenter Client for Microsoft Office and document management.
Before you begin

**Prerequisites**
You do not need Teamcenter administrator privileges to *use* document management functionality, but you do need Teamcenter administrator privileges to *configure* document management functionality. Also, to function correctly, document management depends on other required and optional software.

For information about required and optional software needed to support document management, see *Document management prerequisites*.

**Note** Access to document management functionality may be restricted and you may be unable to start it, even if you have administrator privileges.

**Enable document management**
Document management does not need to be enabled before you use it, but it does require configuration.

If you have trouble accessing document management functionality, see your system administrator; it may be an access issue.

**Configure document management**
Document management must be configured to reflect business processes at your site.

For configuration information, see *Installing and configuring document management*.

**Start using document management**
How you start and use document management depends on whether you use the rich client, the thin client, or Client for Office. For example, in the rich client and the thin client, you usually click *My Teamcenter* in the navigation pane to start using document management functionality. In Client for Office, however, you access document management functionality from the Teamcenter menu.

For additional information, see *Document management in Teamcenter clients*. 
Chapter

2  Basic concepts of document management

- Document management overview ........................................... 2-1
- Document management basics ............................................. 2-1
- Document management examples ........................................ 2-4
Chapter 2  Basic concepts of document management

Document management overview

Document management controls behaviors such as:

• Using templates to specify and standardize document content and to exchange attributes by synchronizing properties.

• Rendering datasets to produce output files in different formats from the input files.

• Displaying document content and supporting document markup.

• Printing documents with system stamps, banner pages, and watermarks.

• Generating thumbnail images from various graphic input formats.

• Digitally signing datasets such as PDF files from Adobe Acrobat and Adobe Reader.

• Using style sheets to configure create dialog boxes and summary display for Document objects in the rich client and the thin client.

When document management is fully implemented, these behaviors are managed during specified actions, such as create, check in, check out, revise, save as (copy), view/markup, and batch print, as well as within the context of broader activities such as workflow interaction and change management.

Document management basics

Document management functionality uses item revision definition configuration (IRDC) objects to simplify user interactions with information. This reduces the need to understand the Teamcenter data model and relationship model.

Based on your business processes, IRDC objects defined in the Teamcenter Business Modeler IDE application let you automate document creation, rendering of presentation formats, document markup, document batch printing, and document availability.
Document management functionality can be configured for any Teamcenter item, but some or all document management behaviors may be unavailable at your site.

For information about basic item behavior in the thin client, see the **Thin Client Interface Guide**.

For information about basic item behavior in the rich client, see the **My Teamcenter Guide**.

For information about working with Teamcenter objects in Teamcenter Client for Microsoft Office (Client for Office), see the **Client for Microsoft Office Guide**.

Document management uses IRDC to specify behaviors for **Document** items, **DMTemplate** items, and **Dataset** items.

- An IRDC object is created by an administrator or a customizer using the Business Modeler IDE application. This object lets you standardize document behavior at specific times in the life cycle of the document. Document behavior can be managed for **New**, **Check In**, **Check Out**, **Copy (Save As)**, **Revise**, **View/Markup**, **Cancel Check-Out**, **Sign**, and **Cancel Signing** actions for a document.

Managed behaviors can include creation and naming of derived visualization datasets, markup rules, and the creation of specified relations.

**Note** Document management behavior configuration is designed primarily for **Document** items, but any of the behaviors can be used for any subtype of the **Item** type.

- The **Document** item is an object you create in Teamcenter. In document management, the document item is associated with one or more templates and dataset items in a manner configured to meet your business requirements. When a document revision is sent to a workflow, a derived dataset can be created and attached to the document revision.

**Note** When you render an item, you create a derived dataset from a source dataset. The render action is initiated from a checkin or from a workflow task. Such derived datasets are typically used when content must be provided outside the authoring organization and the ability to make changes to the original content must be restricted.

For more information about rendering items, see **Rendering documents**.

- The **DMTemplate** item can be created by any user. A Teamcenter administrator can create an IRDC to associate a **DMTemplate** item with a specific item type and specific dataset types.

- The **Dataset** object represents an actual data file on the operating system or in Teamcenter. Datasets are typically authored content of some sort, such as Microsoft Office files or CAD data files.

- Markup access for documents is controlled by the **Markup** privilege, assigned by administrators in Access Manager.
Basic concepts of document management

**Note** Markup is typically used for authoring with controlled iteration in the context of a change control object.

- Documents used in markup are typically in Adobe PDF or Microsoft Word format. When Microsoft Word format is used, a markup summary can be exported to Microsoft Excel.

- Markup in document management is not the same as Lifecycle Visualization markup, which is used for marking up illustrations and Lifecycle Visualization output.

- To perform markup in Adobe Acrobat or Adobe Reader, ensure the documents preference for **PDF/A View Mode** is set to **Never**.

- You can digitally sign a PDF file stored as a dataset named reference file with Adobe Acrobat and Adobe Reader.

  New style sheets let you configure create dialog boxes and summary display for **Document** objects.

  The **Digital Sign Dataset** ACL rule grants the owning user and owning group digital signing privileges for the dataset object.

  **Note** Digital signing is supported only for PDF datasets created in Teamcenter 10.1 or later.

  - In the Adobe Reader, the PDF file must have **Enable Usage Rights for Digitally Sign** enabled.

  - Use Adobe Acrobat or Adobe LiveCycle Reader Extensions to enable usage rights for PDF files.

  - To perform digital signing in Adobe Acrobat or Adobe Reader, ensure the documents preference for **PDF/A View Mode** is set to **Never**.

For information, see *Access privileges and preferences for digital signing*.

**Caution** When you create markups or update markups using Adobe Acrobat or Adobe Reader, the markups must be saved in Teamcenter or canceled before you begin the **Sign** action for the PDF dataset file.

- You can use create style sheets provided for **Document** objects to customize the New Business Object wizard in the rich client and thin client to streamline the document creation process.

  Two user interface dialog boxes added to the New Business Object wizard support:

  - Attaching files to a dataset for a new object.

  - Submitting a new object to workflow.

Additional capabilities provided by document management batch printing include creating configuration objects to manage printer configuration and system stamp configuration. Batch printing lets you select workspace objects, such as items, item revisions, or datasets, and print the associated documents with system stamps and watermarks.
Chapter 2  

Basic concepts of document management

- A system stamp can include the user name, the date and time, and other specified business item attributes. You can also define optional additional user stamps, which can be appended to the system stamp, to select when printing documents. The stamp content and position is specified in a MetaDataStamp (MDS) file. System stamps can be placed on the first page or all pages of the output.

- A watermark is a recognizable image or pattern in paper that appears as various shades of lightness or darkness when viewed by transmitted light or when viewed by reflected light against a dark background. Watermark characteristics are specified in the MDS file.

For more information about working with MDS files, see the *Application Administration Guide*.

Document management also benefits from:

- The use of full-text search retrieval indexes.

  For more information about working with full-text searches, see the *Rich Client Interface Guide*.

- The production of thumbnail graphics.

  For more information about working with thumbnail graphics, see *Generating thumbnail graphics*.

Document management examples

Document management functionality implementations range from minimal to extensive.

In a minimal implementation of document management, users create source documents using templates.

For example, a site can use a Microsoft Office template documents with embedded forms and macros to standardize product documentation. Each template is associated with a specific document type through item revision definition configuration.

- Document templates are created as site-specific files for use by applications such as Microsoft Office, CAD applications, and other programs that generate other proprietary formats. Typically these files have some amount of formatted and boilerplate content included as a starting point for users to create a new file.

- Site-specific Teamcenter document types, item revision definition configuration objects, and tool object attributes are specified in the Business Modeler IDE.

In an extensive implementation of document management:

- Users create source documents using templates for specific document types based on item revision definition configuration (IRDC) objects.

- Documents are rendered from source formats to presentation formats.
  
  o Document rendering uses translation services supported by Dispatcher functionality.

  o Rendering is specified by IRDC and dispatcher service configuration settings.
Rendering can be menu-driven and can be automated based on events such as checkin or from a workflow task.

Rendering in workflows is supported by workflow handlers and IRDCs.

- Documents are retrieved by searching Teamcenter, including the use in full-text search indexes created based on installation of the Autonomy IDOL server.

- Documents undergo managed review and markup within workflows, based on Tool object attributes.

- Document PDF dataset files can be digitally signed.

- Document management batch printing supports multiple document selection, watermarks, banner pages, and system stamps.

- Thumbnails are generated based on IRDC and dispatcher service configuration settings. Like document rendering, thumbnail generation uses translation Dispatcher functionality.
Chapter

3 Installing and configuring document management

Installing and configuring document management ....................... 3-1
Document management prerequisites ........................................ 3-1
Installing document management components .............................. 3-3
Configuring full-text search .................................................... 3-4
Using the Business Modeler IDE to configure document management ........ 3-4
Using style sheets .................................................................. 3-5
Rendering documents ................................................................ 3-6
  Prerequisites for rendering .................................................. 3-6
  Supported input and output file types ...................................... 3-8
Rendering thumbnail graphics .................................................. 3-9
  Prerequisites for thumbnail generation .................................... 3-10
Configuring batch printing ....................................................... 3-11
  Batch printing prerequisites .................................................. 3-11
  Creating a print configuration ................................................. 3-12
  Creating a system stamp configuration .................................... 3-12
  Configure banner pages for batch printing ............................. 3-12
  Using the MDS file ............................................................. 3-13
  Setting access privileges for batch printing ......................... 3-14
  File formats for batch printing ............................................ 3-15
Markup capabilities in Teamcenter ............................................. 3-20
Configuring document markup ................................................ 3-21
  Document markup prerequisites ............................................ 3-21
  Configure item revision definition configuration (IRDC) objects .... 3-21
  Creating and modifying tool objects ....................................... 3-21
  Setting access privileges for markups .................................... 3-22
Access privileges and preferences for digital signing .................... 3-23
  Configuration preferences for application launch from Microsoft Office .... 3-24
Import a sample document management template file .................. 3-25

Getting Started with Document Management
Chapter

3 Installing and configuring document management

Installing and configuring document management

Document management functionality depends on correct installation and configuration, as well as the presence of prerequisite software.

For information about configuring document management, see the Application Administration Guide.

Document management prerequisites

Document management prerequisites include the following:

- For creating document template data files and document data files:
  - Appropriate document file software, such as Microsoft Word, Microsoft Excel, or a comparable product.
  - DMTemplate and Document type items associated with item revision definition control objects.

  For information about configuring document management templates, see the Application Administration Guide.

- For rendering documents, one or both of the following must be installed and configured:
  - Teamcenter 10.1 lifecycle visualization Convert, Ghostscript version 8.64 (Asian font version) and MS Office 2007 or 2010.
  - Adobe LiveCycle PDF Generator ES version 8.2.1 or ES2 version 9.0, Adobe Acrobat Pro Extended version 9.2 (for information, see the Adobe LiveCycle ES2 documentation), and a source format authoring application (for example, MS Office: 2003, XP, or 2007).
  - Teamcenter RenderMgtTranslator translator, and PreviewService translator for Teamcenter lifecycle visualization Convert or PdfGenerator translator for Adobe LiveCycle PDF Generator.

    For information about enabling the RenderMgtTranslator translator, see the Dispatcher Server Translators Reference Guide.

- For batch printing:
Chapter 3  Installing and configuring document management

- Teamcenter 10.1 lifecycle visualization Print, Ghostscript version 8.64 (Asian font version)

- Teamcenter batchprint translator
  
  For information about enabling the batchprint translator, see the Dispatcher Server Translators Reference Guide.

  For information about configuring UNIX printers for batch printing, see the Application Administration Guide.

  • For document markup:
    - One or more markup tools such as Adobe Acrobat and Microsoft Word.

    Note  To use Adobe Acrobat for markup, the Teamcenter Acrobat/Reader plugin must be installed by the Teamcenter Environment Manager (TEM).

    - Teamcenter Client for Microsoft Office (Client for Office): To save the markups created in Microsoft Word directly to Teamcenter.

      For more information, see the Client for Microsoft Office Guide.

    - Commercial off-the-shelf (COTS) TcViewMarkupApplicationPref site preference sets the preferred tool as PDF_Tool and MSWord. Users can set this preference to set the preferred tool.

    Note  Commercial off-the-shelf (COTS) access control lists (ACLs) do not grant World View/Markup access privilege. User may not be able to perform markup (view only mode) if the dataset is not owned by the user or group.

    - Commercial off-the-shelf (COTS) TCDigitalSigningApplicationPref site preference sets the preferred tool as PDF_Tool to use Adobe Reader for PDF signing. Users can set this preference to set the preferred tool.

    Note  Only a Tool name for a tool that has the Digital Signature Capable option selected is valid.

    - (Optional) Document rendering for converting Microsoft Office files to PDF format.

  • For generating thumbnail images:
    - Teamcenter 10.1 lifecycle visualization Convert, Ghostscript version 8.64 (Asian font version).

    - Teamcenter previewservice and the rendermgtransltor translators.

      For information about verifying that translators are configured for render management, see the Dispatcher Server Translators Reference Guide.

  • For full-text search:
    - Autonomy full-text search engine installation.

    - Full-text search preferences configuration.
Installing and configuring document management

- Teamcenter **build_fts_index** utility to build indexes for the Autonomy search engine on an object-by-object basis. These indexes enable the Teamcenter full-text keyword search and can index both the properties of Teamcenter dataset objects and the contents of dataset files.

  For information about using the **build_fts_index** utility, see the *Utilities Reference*.

### Installing document management components

Use Teamcenter Environment Manager (TEM) to install components used in document management. Such components include:

- **Dispatcher and Dispatcher client.**
  Dispatcher enables users to translate and render Teamcenter-managed data files.

  For information about installing Dispatcher and Dispatcher client, see the *Teamcenter Environment Manager Help*.

- **Autonomy full-text search (FTS) engine**

  For information about installing the full-text search engine, see the *Teamcenter Environment Manager Help*.

Use the appropriate server installation guide (for Windows or UNIX/Linux) to install the following:

- **Render management**

  Install document rendering if you want to translate Microsoft Office files to PDF format or generate thumbnail images.

  For more information, see the appropriate server installation guide (for Windows or UNIX/Linux).

- **Teamcenter features**, including Teamcenter Foundation, the appropriate clients, Business Modeler IDE, Sample Files, Full Text Search Engine, Teamcenter Client for Microsoft Office, Dispatcher Client for Rich Client, Render Document for Rich Client, Dispatcher Server, and Dispatcher Client.

  For more information, see the appropriate server installation guide (for Windows or UNIX/Linux).


  For more information, see the appropriate server installation guide (for Windows or UNIX/Linux).

- **(Optional) Client Windows installation only**
  - **Office Client for Microsoft Office.**

  To view or mark up PDF files using Adobe Acrobat or Reader, first install Adobe Acrobat/Reader version 9, or Reader 10, and then install the Acrobat/Reader Plugin feature under Extensions → Content and Document Management in TEM.
Configuring full-text search

Full-text search functionality depends on the following:

- Installation of the Autonomy full-text search engine
  For information about installing the full-text search engine, see the Teamcenter Environment Manager Help.

- Definition of a set of configuration preferences
  For information about full-text search engine preferences, see the Preferences and Environment Variables Reference.

- Utilization of the build_fts_index utility
  An administrator can use the build_fts_index utility to build keyword indexes for the Autonomy search engine on an object-by-object basis for both the properties of dataset objects and the contents of dataset files.
  For information about this utility, see the Utilities Reference.

Note
The Autonomy search engine supports numerous data formats.

For information about Autonomy information connectivity, supported formats, and related resources, see the Autonomy Web site:

http://www.autonomy.com/content/Technology/idol-functionality-information-connectivity/index.en.html

For more information about configuring full-text search, see the Application Administration Guide.

Using the Business Modeler IDE to configure document management

Document management lets end users manage documents in Teamcenter, including the capability to render view-only versions, manage markups, and define print configurations and system stamp configurations.

Note
To use PDF markup capabilities, you must create a tool for markup.

For more information about how to create a tool, see the Business Modeler IDE Guide.

In the Advanced perspective, the Document Management folder in the Extensions folder of the Business Modeler IDE allows an administrator to create the following objects that are used for document management:

- Item revision definition configurations (IRDCs)
  IRDCs define how item revisions are handled. IRDCs standardize item revision behavior at specific times in the lifecycle, such as at item creation, checkin, checkout, view/markup, save as, and revise.
  For more information about creating an item revision definition configuration (IRDC), see the Business Modeler IDE Guide.

- Dispatcher service configurations
A dispatcher service configuration is an object that defines the visualization file format that a dataset file is translated into. For example, it may specify that Microsoft Word documents are translated into PDF files.

For more information about creating dispatcher service configurations, see the Business Modeler IDE Guide.

- Print configurations
  A print configuration is an object that defines batch print settings.
  For more information about creating print configurations, see the Business Modeler IDE Guide.

- System stamp configurations
  A system stamp configuration is an object that defines the system stamp on documents when batch printing.
  For more information about creating system stamp configurations, see the Business Modeler IDE Guide.

Teamcenter does not provide commercial off-the-shelf (COTS) dispatcher service configurations or IRDCs, but you can import a sample document management template file that contains examples.

For more information about importing the sample document management template file, see the Business Modeler IDE Guide.

Using style sheets

You can streamline the document creation process by using style sheets provided for Document objects to customize the New Business Object wizard and the Summary view in the rich client and the thin client.

Display the New Business Object wizard in your client. Then, to access the customized wizard, select Document as the object type to create.

- In the thin client, choose New→Other or New→Item to display the New Business Object wizard.

- In the rich client, choose File→New→Other or File→New→Item to display the New Business Object wizard.

- In Client for Office, click the New button on the command ribbon to display the New Business Object wizard.

In the rich client and the thin client, the Summary pane is displayed on the right side of the window when a Document or Document Revision object is selected in the navigation pane.

Summary style sheets customize the Summary pane in the rich client and the thin client.

- New summary style sheets are provided for Document and Document Revision objects to customize the layout for those objects.
Chapter 3  Installing and configuring document management

- Along with layout changes, a **View/Markup** action is added to **Actions** list on the **Summary** pane.

For more information about using style sheets, see the *Client Customization Programmer’s Guide*.

Rendering documents

Render management is a framework to support the automatic translation of files from a source format to a *derived visualization data*, or presentation data, format. You can configure render management to operate on demand, within a workflow, or during specified events such as checkin.

**Note** In Teamcenter, **rendering** invokes the data translations specified for an item, such as a document revision, to generate derived visualization data.

*Translation* converts data from one file format into another file format. In the context of Teamcenter document management, source data is converted to derived visualization data formats. The conversion is based on available translators.

Therefore, you render an item revision, but you translate a dataset.

When you render an item revision containing a dataset, you translate the associated file to an alternate format. This results in a derived visualization data dataset file translated from the source dataset. For example, you can render an item revision with an attached Microsoft Office dataset file to add a derived Adobe PDF dataset file to the item revision.

- To render an item revision directly in the rich client, use the **Translation**→**Render Document** menu command.

For more information about rendering documents in the rich client, see the *My Teamcenter Guide*.

- An administrator can make translation and rendering automatic, as part of a workflow or checkin process. The administrator uses the Business Modeler IDE to configure an item revision definition configuration (IRDC) object for the appropriate item type and to create a dispatcher service configuration object to determine the dispatcher service, source dataset type, and desired derived dataset type.

For more information about working with document management IRDC objects, see the *Business Modeler IDE Guide*.

**Note** If you are creating and managing work instructions in PDF format using the Manufacturing Process Planner application, do not follow the procedures in this guide. Instead, see *Getting Started with Manufacturing* and the *Manufacturing Process Planner Guide* for more information.

Prerequisites for rendering

The prerequisites for rendering documents in Teamcenter include the following:

- Install and configure one or both of the following:
Installing and configuring document management

- Teamcenter 10.1 lifecycle visualization Convert and Print, Ghostscript version 8.64 (Asian font version) and MS Office 2007 or 2010.

- Adobe LiveCycle PDF Generator ES version 8.2.1 or ES2 Version 9.0, Adobe Acrobat Pro Extended version 9.2 (for information, see the Adobe LiveCycle ES2 documentation), and a source format authoring application (for example, MS Office: 2003, XP, or 2007).

**Note** For information about downloading Ghostscript, see the following URL:


- Install document render functionality by installing and configuring a Dispatcher Server and Dispatcher Client, under **Corporate Server**, in Teamcenter Environment Manager (TEM).

  For more information, see *Getting Started with Dispatcher (Translation Management)* and the **Dispatcher Server Translators Reference Guide**.

- Install and configure the **previewservice**, **rendermgctranslator**, and **pdfgenerator** (supported by default only on Windows) translators.

  For information about verifying that translators are configured for render management, see the **Dispatcher Server Translators Reference Guide**.

- Set up item revision definition configuration (IRDC) and dispatcher service configuration objects and deploy to the Teamcenter database.

  For more information about working with document management IRDC objects and dispatcher service configuration objects, see the **Business Modeler IDE Guide**.

To render documents, you must first install render management components in your Teamcenter configuration.

For more information, see the appropriate server installation guide (for Windows or UNIX/Linux).

The software needed for rendering is dictated by the available input formats and the required output formats.

<table>
<thead>
<tr>
<th>Input format</th>
<th>Output format</th>
<th>Required software</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS Office, PostScript</td>
<td>PDF</td>
<td>Teamcenter 10.1 lifecycle visualization Convert, Ghostscript version 8.64 (Asian font version) and MS Office: 2007 or 2010</td>
</tr>
<tr>
<td>MS Office</td>
<td>PostScript</td>
<td>Teamcenter 10.1 lifecycle visualization Convert, Ghostscript version 8.64 (Asian font version) and MS Office: 2007 or 2010</td>
</tr>
</tbody>
</table>

1. Supported MS Office formats include Microsoft Word, Excel, PowerPoint, WordX, ExcelX and PPTX, unless otherwise noted.
## Supported input and output file types

The following output file types are supported by render management translators.

<table>
<thead>
<tr>
<th>Dataset type</th>
<th>Output file extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>*.pdf</td>
</tr>
<tr>
<td>PostScript</td>
<td>*.ps and *.eps</td>
</tr>
<tr>
<td>TIF</td>
<td>*.tif</td>
</tr>
<tr>
<td>MSProject</td>
<td>*.mpp</td>
</tr>
<tr>
<td>WordPerfect</td>
<td>*.wpd</td>
</tr>
<tr>
<td>Bitmap</td>
<td>*.bmp</td>
</tr>
<tr>
<td>GIF</td>
<td>*.gif</td>
</tr>
<tr>
<td>JPEG</td>
<td>*.jpg</td>
</tr>
<tr>
<td>DXF</td>
<td>*.dxf</td>
</tr>
<tr>
<td>HPGL</td>
<td>*.hpgl</td>
</tr>
</tbody>
</table>

### Input format 2

<table>
<thead>
<tr>
<th>Input format</th>
<th>Output format</th>
</tr>
</thead>
<tbody>
<tr>
<td>MS Office (Word, Excel, PowerPoint), PostScript</td>
<td>PDF</td>
</tr>
<tr>
<td>MS Office (Word, Excel, PowerPoint)</td>
<td>PostScript</td>
</tr>
<tr>
<td>MS Office (Word, Excel, PowerPoint)</td>
<td>TIF</td>
</tr>
<tr>
<td>DXF, HPGL, Text, PostScript, PDF</td>
<td>Thumbnail (JPEG)</td>
</tr>
</tbody>
</table>

---

2. Supported MS Office formats include Microsoft Word, Excel, PowerPoint, WordX, ExcelX and PPTX, unless otherwise noted.
Rendering thumbnail graphics

Thumbnail graphics for items, item revisions, and datasets are displayed in My Teamcenter in the **Search Results** and **Summary** views.

For information about generating or updating thumbnail graphics in the rich client, see the *My Teamcenter Guide*.

---

**Note**  
Enabling thumbnails adds extra work at all levels of the Teamcenter architecture.

- Thumbnail files are generated using render services.
- Thumbnail files are stored with the associated graphic dataset.
- To display thumbnails in a Teamcenter client, the thumbnails are retrieved from the Teamcenter server.
- In a large search result, many thumbnail files are retrieved from the Teamcenter server.
Before deploying thumbnail functionality globally in your organization, you should assess whether this feature meets the performance requirements in your specific Teamcenter configuration.

**Prerequisites for thumbnail generation**

The following are prerequisites for thumbnail generation:

- **Teamcenter 10.1 lifecycle visualization Convert, Ghostscript version 8.64 (Asian font version).**

- Install document rendering functionality by installing and configuring a Dispatcher and Dispatcher client.
  
  For more information, see *Getting Started with Dispatcher (Translation Management).*

- Install and configure the `previewservice` and the `rendermgtrtranslators` translators.
  
  For information about verifying that translators are configured for render management, see the *Dispatcher Server Translators Reference Guide.*

- Set up item revision definition configuration (IRDC) and dispatcher service configuration objects and deploy to the Teamcenter database.

  IRDC and dispatcher service configuration defines thumbnail file formats and item revision behavior.

  A sample IRDC and dispatcher service configuration file is provided. Install this sample file from Teamcenter Environment Manager. In the **Select Features** panel, under **Server Enhancements**, select **Sample files**.

  This sample file is located in the `TC_ROOT/sample/thumbnail_mgt` directory.

  **Note** Configure the sample IRDC to include all the file types you use in your business processes.

  If you do not include the file types you use in the IRDC, the dataset may show an incorrect thumbnail. Example: A Microsoft Word document may be shown as an image rather than Word.

  **Note** If you use IRDC and dispatcher service configuration objects that conflict with definitions in the sample file, you must merge the common definitions into one set of objects before using them.

  For more information about working with document management IRDC objects and dispatcher service configuration objects, see the *Business Modeler IDE Guide.*

- Set the following preferences:
  
  **Enable_thumbnails**
  
  Enables thumbnails for the site.

  Set value to **true**.
Configuring batch printing

To configure batch printing, you must:

- Ensure batch printing prerequisites are met.
- Create print configuration objects.
- (Optional) Create a system stamp configuration object.
- Set batch printing access privileges.

Batch printing prerequisites

- Install Business Modeler IDE on the machine where the printers are configured.
- Teamcenter 10.1 lifecycle visualization Print, Ghostscript version 8.64 (Asian font version).
- Install and configure Dispatcher and Dispatcher client.
  For more information, see Getting Started with Dispatcher (Translation Management).
- Install the batchprint translator.
  For more information, see the Dispatcher Server Translators Reference Guide.
- Create the MetaDataStamp (MDS) template or import the sample MDS template (DMTemplate object).
  For more information about creating a MetaDataStamp (MDS) file, see Using the MDS file.
Teamcenter 10.1 lifecycle visualization Print, Dispatcher, and the Business Modeler IDE must be installed on the same machine. Other configurations are not supported for batch printing.

For information about configuring UNIX printers for batch printing, see the *Application Administration Guide*.

**Creating a print configuration**

A print configuration is an object that defines batch print settings.

For more information about creating print configurations, see the *Business Modeler IDE Guide*.

**Creating a system stamp configuration**

A system stamp configuration is an object that defines the system stamp on documents when batch printing.

For more information about creating system stamp configurations, see the *Business Modeler IDE Guide*.

**Configure banner pages for batch printing**

Teamcenter uses the Lifecycle Visualization application Convert and Print through the Dispatcher, with conversions by the **previewservice** translator and print requests by the **batchprint** translator. You control banner page printing by setting configuration values in the **vvcp.ini** file and by setting options in the batch print dialog box.

You can use printed banner pages to help organize print jobs. You can use banner page printing when numerous print jobs are sent to one or more printers, and you want to distinguish where one print job ends and another begins.

To configure banner pages for batch printing, perform these steps:

1. Open the Lifecycle Visualization print configuration file (**vvcp.ini** file on Windows systems and **vvcp.platform.cfg** on Linux systems).

   This configuration file is created in the **\Visualization\VVCP** directory on Windows systems (or the **visualization/app_defaults** directory on Linux systems) when Convert and Print is installed by the Lifecycle Visualization installer or by Teamcenter Environment Manager (TEM).

2. Set the following attributes:
   - **Banner**
     Specifies banner pages for all printers.
   - **PrinterBanner**
     Specifies the banner page for a specific printer. This overrides the **Banner** setting for the specified printer.
   - **BannerFormat**
Specifies either text (TXT) or metadata stamping (MDS) format for banner page processing.

- **BannerFormat=mds (BannerFormat: mds on Linux systems)**
  The banner page is a stamp file printed without an underlying image. All the MDS commands are supported except \File and \FilePath.

- **BannerFormat=txt (BannerFormat: txt on UNIX systems)**
  The banner page content comes from a text file.
  TXT format supports only the following MDS commands:

  \Attribute
  \Copies
  \Date
  \Time

  **Note** You must not provide values for BannerInfo and PrinterBannerInfo. Teamcenter provides these values.

For information about configuring banner page printing, see the *Introduction to Convert and Print* guide provided with the Lifecycle Visualization application Convert and Print software.

### Using the MDS file

You can create a MetaDataStamp (MDS) file which specifies document watermarking and stamping options.

**Note** To print system stamps for item revisions and stand-alone datasets, you must do one of the following:

- Create and install your own MDS template.
- Import the default `batchprint.mds` sample MDS template.

The `batchprint.mds` sample MDS file is provided in the **DTemplates** directory:

```
TC_ROOT/sample/document_management/importdmtemplates/DTemplates
```

A `readme.pdf` file is provided in the following directory:

```
TC_ROOT/sample/document_management
```

Create a MetaDataStamp (MDS) file that specifies document watermarking and stamping options. You use this MDS file when creating the system stamp configuration object in the Business Modeler IDE.

**Note** A `batchprint.mds` sample MDS file is provided in the **DTemplates** directory:

```
TC_ROOT/sample/document_management/importdmtemplates/DTemplates
```

The following metadata attribute keys are available for batch printing:
**DateAndTime**  
Date and time string generated by Teamcenter when the batch print request was issued.

**UserStamp**  
User stamp from the system stamp configuration object.

**SystemStamp**  
System stamp from the system stamp configuration object.

**WaterMark**  
Watermark from the system stamp configuration object.

**DialogUserStamp**  
User stamp from the batch print dialog.

**TCUserName**  
Teamcenter user name.

**FullUserName**  
Teamcenter full user name.

**OSUserName**  
Teamcenter operating system user name.

For information about options for the MDS file, see the *Application Administration Guide* and the *Introduction to Convert and Print* guide, which is available in the Lifecycle Visualization help collection.

### Setting access privileges for batch printing

Teamcenter provides access control lists (ACLs) for managing batch printing information.

The following ACLs are located in Access Manager under **Has Class(POM_application_object)**:

- **Batch Print Item**  
  Batch print action privileges for items.

  **Working→Has Class(Item)→Batch Print Item**

- **Batch Print Item Revision**  
  Batch print action privileges for item revisions.

  **Working→Has Class(Item Revision)→Batch Print Item Revision**

- **Batch Print Dataset**  
  Batch print action privileges for datasets.

  **Working→Has Class(Dataset)→Batch Print Dataset**

You can modify these ACLs or create others using Access Manager.

*Note*  
Commercial off-the-shelf (COTS) ACLs do not grant **World** batch print access privilege. To print dataset files you do not own, the ACLs must be modified to grant batch print access privileges.

For more information about using Access Manager, see the *Access Manager Guide*. 
File formats for batch printing

You can use the following table to:

- Review the list of supported input file formats.
- Verify the description for each file.

<table>
<thead>
<tr>
<th>Input file extension</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>907</td>
<td>Calcomp 906/907</td>
<td>None</td>
</tr>
<tr>
<td>951</td>
<td>Calcomp 951</td>
<td>None</td>
</tr>
<tr>
<td>adwf</td>
<td>AutoCAD DWF</td>
<td>Supported file types include AutoCAD 2004 through AutoCAD 2010.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When you open a 2D file using a 64-bit operating system, 3D solids</td>
</tr>
<tr>
<td></td>
<td></td>
<td>are not supported.</td>
</tr>
<tr>
<td>ai</td>
<td>Adobe Illustrator</td>
<td>For Windows 32-bit systems, AI, PDF, and PDFA files are processed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>by the software unless PDFLoader is set to off. If PDFLoader is</td>
</tr>
<tr>
<td></td>
<td></td>
<td>disabled, Ghostscript is used to process the files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For Linux or MacOS systems, AI files are processed with Ghostscript.</td>
</tr>
<tr>
<td>bmp</td>
<td>Windows Bitmap</td>
<td>None</td>
</tr>
<tr>
<td>c4</td>
<td>JEDMICS C4</td>
<td>None</td>
</tr>
<tr>
<td>cc3</td>
<td>CCITT Group 3 Raster</td>
<td>None</td>
</tr>
<tr>
<td>cc4</td>
<td>CCITT Group 4 Raster</td>
<td>None</td>
</tr>
<tr>
<td>cgm</td>
<td>Computer Graphics Metafile</td>
<td>Supported file types include WebCGM and CGM V4.</td>
</tr>
<tr>
<td>dft</td>
<td>Solid Edge Draft</td>
<td>None</td>
</tr>
<tr>
<td>dgn</td>
<td>Microstation DGN</td>
<td>None</td>
</tr>
<tr>
<td>doc</td>
<td>Microsoft Word document</td>
<td>You must install the native application and Ghostscript on the server to print these files.</td>
</tr>
<tr>
<td>docx</td>
<td>Microsoft Word 2007 document</td>
<td>You must install the native application and Ghostscript on the server to print these files.</td>
</tr>
</tbody>
</table>
### Input file extension

<table>
<thead>
<tr>
<th>Extension</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>dwg</td>
<td>AutoCAD DWG</td>
<td>Supported file types include AutoCAD 2004 through AutoCAD 2010. When you open a 2D file using a 64-bit operating system, 3D solids are not supported. The following types of embedded raster data are supported: BMP, JPG, GIF, MLR, TIFF, and PNG.</td>
</tr>
<tr>
<td>dxf</td>
<td>AutoCAD DXF</td>
<td>Supported file types include AutoCAD 2004 through AutoCAD 2010. When you open a 2D file using a 64-bit operating system, 3D solids are not supported. The following types of embedded raster data are supported: BMP, JPG, GIF, MLR, TIFF, and PNG.</td>
</tr>
<tr>
<td>emf</td>
<td>Enhanced Windows Metafile</td>
<td>None</td>
</tr>
<tr>
<td>etf</td>
<td>Encoded TIFF</td>
<td>None</td>
</tr>
<tr>
<td>gbr</td>
<td>Gerber</td>
<td>None</td>
</tr>
<tr>
<td>gif</td>
<td>GIF Color Image</td>
<td>None</td>
</tr>
<tr>
<td>hpg</td>
<td>HP-GL Vector</td>
<td>None</td>
</tr>
<tr>
<td>idw</td>
<td>IDW Inventor</td>
<td>None</td>
</tr>
<tr>
<td>igs</td>
<td>IGES</td>
<td>None</td>
</tr>
<tr>
<td>jpg</td>
<td>JPEG Image</td>
<td>None</td>
</tr>
<tr>
<td>j2k</td>
<td>JPEG 2000 (j2k, jpc, and jp2)</td>
<td>You can use the command line parameter <code>-monocolor</code> or the <code>Monocolor</code> configuration file setting to force any input file type that supports color to monocolor output.</td>
</tr>
<tr>
<td>mdl</td>
<td>Vis View Model</td>
<td>None</td>
</tr>
<tr>
<td>mds</td>
<td>Vis View Meta Data Stamp</td>
<td>None</td>
</tr>
<tr>
<td>mlr</td>
<td>MIL-Raster 28002</td>
<td>None</td>
</tr>
<tr>
<td>Input file extension</td>
<td>Description</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>mpp</td>
<td>Microsoft Project</td>
<td>Convert uses the native application to convert file formats using the external converter. These file formats are office applications such as MS Word. Siemens PLM Software does not supply native applications. For MS Office files, Convert and Print cannot run as a Windows service.</td>
</tr>
<tr>
<td>pbm</td>
<td>Portable BitMap Image File</td>
<td>None</td>
</tr>
<tr>
<td>pct</td>
<td>Macintosh Paint Image</td>
<td>None</td>
</tr>
<tr>
<td>pcx</td>
<td>PC Paintbrush Image</td>
<td>None</td>
</tr>
<tr>
<td>pdf</td>
<td>Portable Document Format</td>
<td>For Windows 32-bit systems, AI, PDF, and PDFA files are processed by the software unless PDFLoader is set to off. If PDFLoader is disabled, Ghostscript is used to process the files. For Linux or MacOS systems, AI files are processed with Ghostscript.</td>
</tr>
<tr>
<td>pdfa</td>
<td>Portable Document Format – archiving</td>
<td>For Windows 32-bit systems, AI, PDF, and PDFA files are processed by the software unless PDFLoader is set to off. If PDFLoader is disabled, Ghostscript is used to process the files. For Linux or MacOS systems, AI files are processed with Ghostscript.</td>
</tr>
<tr>
<td>pgm</td>
<td>Portable GrayMap Image File</td>
<td>None</td>
</tr>
<tr>
<td>png</td>
<td>Portable Network Graphic</td>
<td>None</td>
</tr>
<tr>
<td>pnm</td>
<td>Portable Anymap</td>
<td>None</td>
</tr>
<tr>
<td>ppm</td>
<td>Portable PixMap image file</td>
<td>None</td>
</tr>
<tr>
<td>ppt</td>
<td>Microsoft PowerPoint</td>
<td>Convert uses the native application to convert file formats using the external converter. These file formats are office applications such as MS Word. Siemens PLM Software does not supply native applications. For MS Office files, Convert and Print cannot run as a Windows service.</td>
</tr>
<tr>
<td>Input file extension</td>
<td>Description</td>
<td>Notes</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>pptx</td>
<td>Microsoft PowerPoint 2007</td>
<td>Convert uses the native application to convert file formats using the external converter. These file formats are office applications such as MS Word. Siemens PLM Software does not supply native applications. For MS Office files, Convert and Print cannot run as a Windows service.</td>
</tr>
<tr>
<td>prt</td>
<td>NX Part</td>
<td>PRT files are only supported on Windows, Linux, and Macintosh.</td>
</tr>
<tr>
<td>ps</td>
<td>PostScript</td>
<td>Full support for color output is available. You cannot, however, create color output from noncolor source files. You can create grayscale formatted files from color source files. Color files converted to grayscale permanently lose their color data. You can use Ghostscript to work with PostScript, PDF, and AI files.</td>
</tr>
<tr>
<td>pvl</td>
<td>Vis View Viewlist</td>
<td>None</td>
</tr>
<tr>
<td>rtf</td>
<td>Microsoft Rich Text Format</td>
<td>Convert uses the native application to convert file formats using the external converter. These file formats are office applications such as MS Word. Siemens PLM Software does not supply native applications. For MS Office files, Convert and Print cannot run as a Windows service.</td>
</tr>
<tr>
<td>tg4</td>
<td>Intergraph Tiled Group 4</td>
<td>None</td>
</tr>
<tr>
<td>tga</td>
<td>Truevision Targa</td>
<td>None</td>
</tr>
</tbody>
</table>
| tif                  | TIFF Raster                  | Convert uses the native application to convert file formats using the external converter. These file formats are office applications such as MS Word. Siemens PLM Software does not supply native applications. You can use the command line parameter `-monocolor` or the Monocolor configuration file setting to force any input file type
<table>
<thead>
<tr>
<th>Input file extension</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>tlc</td>
<td>TLC Raster</td>
<td>that supports color to monochrome output.</td>
</tr>
<tr>
<td>triff</td>
<td>TRIFF</td>
<td>None</td>
</tr>
<tr>
<td>txt</td>
<td>Text</td>
<td>None</td>
</tr>
<tr>
<td>ubn</td>
<td>Uncomp. Binary Raster</td>
<td>None</td>
</tr>
<tr>
<td>uhx</td>
<td>Uncomp. Hexadecimal Raster</td>
<td>None</td>
</tr>
<tr>
<td>vf</td>
<td>Vis View Session File</td>
<td>None</td>
</tr>
<tr>
<td>vsd</td>
<td>Visio Drawing</td>
<td>Convert uses the native application to convert file formats using the external converter. These file formats are office applications such as MS Word. Siemens PLM Software does not supply native applications.</td>
</tr>
<tr>
<td>w2d</td>
<td>AutoDesk toolkit</td>
<td>None</td>
</tr>
<tr>
<td>wbmp</td>
<td>Wireless Bitmap</td>
<td>None</td>
</tr>
<tr>
<td>xls</td>
<td>MS Excel</td>
<td>Convert uses the native application to convert file formats using the external converter. These file formats are office applications such as MS Word. Siemens PLM Software does not supply native applications.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For MS Office files, Convert and Print cannot run as a Windows service.</td>
</tr>
<tr>
<td>xlsx</td>
<td>MS Excel 2007</td>
<td>Convert uses the native application to convert file formats using the external converter. These file formats are office applications such as MS Word. Siemens PLM Software does not supply native applications.</td>
</tr>
<tr>
<td>zip</td>
<td>ZIP Compressed File</td>
<td>None</td>
</tr>
<tr>
<td>z</td>
<td>UNIX Compressed File</td>
<td>None</td>
</tr>
</tbody>
</table>

For more information about file formats, see *Introduction to Convert and Print* guide, which is available in the Lifecycle Visualization help collection.
Markup capabilities in Teamcenter

Teamcenter provides document, product structure, and product visualization markup capabilities.

- Document markup is typically used for authoring with controlled iteration, through workflows, either stand-alone or in the context of a change control object.
  - Markup can be managed by access control lists (ACLs) in Access Manager.
  - Documents used in markup are typically in Adobe PDF or Microsoft Word format.
  - Users can create a disposition reports in Microsoft Word using the Markup Manager.
  - Document markup capabilities are available in the rich client, thin client, and the Teamcenter Client for Microsoft Office (Client for Office).

For information about configuring document markup, see Configuring document markup.

- Product structure markup is not part of document management and is used to indicate proposed changes on the product structure or an assembly.
  - Addition or removal of an occurrence.
  - Addition or removal of a substitute for a line.
  - Replacement of a line (a change to the item revision when in precise mode or to the item when in imprecise mode).
  - Change to the value of certain occurrence properties, for example, name, notes, quantity, sequence number, unit of measure, reference designator, and variant condition.
  - The properties that are tracked in markups are defined in the Fnd0BOMMarkupSupportedProperties global constant in the Business Modeler IDE. You can add properties to this global constant, but you cannot delete the default entries.

For more information about product structure markup, see the Multi-Structure Manager Guide, the Manufacturing Process Planner Guide, and the Structure Manager Guide.

- Product visualization markup is not part of document management and is used for marking up illustrations and Lifecycle Visualization.
  - 2D markups of 2D images from DirectModel datasets.
  - 2D GD&T markups used with 2D images to capture tolerance specifications
  - ECAD (electrical computer-aided design) markups for PCB (printed circuit board) files.
  - 3D markups of 3D images or schematic diagrams.
0 3D GD&T markups used with 3D models to capture tolerance specifications.

0 Thrustlines used with 3D models to show relationships between parts (assembly order, and so forth).

0 PMI used with 3D models to capture manufacturing information.

Note Unlike the other types of markups described, PMI can be viewed in Lifecycle Visualization but not created.

For information visualization options, see Getting Started with Product Visualization.

Configuring document markup
To configure document markup, you must:

• Ensure document markup prerequisites are met.

• Configure IRDC objects.

• Create or update markup tool objects, such as PDF_Tool and MSWord.

• Set markup access privileges.

• Configure digital signing, if needed.

Document markup prerequisites

• Install markup tools such as Adobe Acrobat and Microsoft Word.

• Install Teamcenter Client for Microsoft Office (Client for Office).
  You install this to save markups created in Microsoft Word directly to Teamcenter.

• (Optional) Install document rendering functionality.
  You install document rendering to convert Microsoft Office files to PDF format.
  For more information, see Rendering documents.

Configure item revision definition configuration (IRDC) objects
An administrator can update the IRDC Markup tab with markup information.
For more information, see the Business Modeler IDE Guide.

Creating and modifying tool objects
An administrator can create or modify tool objects to support markups and select the Markup Capable option.

The Markup Capable option lets users perform markup actions using third-party tools such as Adobe Acrobat for PDF file format, Adobe Reader for PDF reader
enabled, or Microsoft Word for .doc/.docx file format. If the **Markup Capable** option is not selected, users can only view markup.

For more information about how to create a tool, see the *Business Modeler IDE Guide*.

### Setting access privileges for markups

Teamcenter provides access control lists (ACLs) for managing markup information. The following ACLs are located in Access Manager under Has Class(POM_application_object).

- **Markup Item**
  View and markup action privileges for items.

  Working→Has Class(Item)→Markup Item

- **Markup Item Revision**
  View and markup action privileges for item revisions.

  Working→Has Class(Item Revision)→Markup Item Revision

- **Markup Dataset**
  View and markup action privileges for datasets.

  Working→Has Class(Dataset)→Markup Dataset

- **Private Markup** and **Hidden Markup**
  Read, write, and delete privileges for datasets having private markups.

  Working→Has Attribute(Dataset:markup_acl=PrivateMarkup)→Private Markup

- **General Markup**
  Read, write, and delete privileges for datasets having general markups.

  Working→Has Attribute(Dataset:markup_acl=GeneralMarkup)→General Markup

- **Markup Official**
  Read, write, checkin, checkout, and delete privileges for datasets having official markups.

  Working→Has Attribute(Dataset:markup_official=1)→Markup Official

You can modify these ACLs or create others using Access Manager.
Note: The system also provides ACLs for Markup.

These ACLs are used with the Markup Capable option value to determine whether users can perform markups or only view content.

You can use a workflow to grant the markup privilege when appropriate in a review task, or you can change the access rule to manage it by owner group and role.

The commercial off-the-shelf (COTS) ACL does not grant World View/Markup access privilege. To let users mark up a rendered PDF file you can do either of the following:

- Edit the Dispatcher client configuration file
  \dispatcher_root\DispatcherClient\conf\Service.properties to set
  Service.DataSetOwner=CAD.

  This generates PDF datasets with the same owner as the source dataset; otherwise the datasets are owned by dcproxy.

- Grant World View/Markup access privilege for the ACL rules.

  Without this, other users can only view the markups and cannot create and save PDF markups using Adobe Acrobat.

Note: You can use a workflow to grant the markup privilege when appropriate in a review task.

For more information about using Access Manager, see the Access Manager Guide.

Access privileges and preferences for digital signing

You can digitally sign a PDF file stored as a dataset named reference file with:

- Adobe Acrobat

- Adobe Reader

  Note: For Adobe Reader, the PDF file must have Enable Usage Rights for Digitally Sign enabled.

  Use Adobe Acrobat or Adobe LiveCycle Reader Extensions to enable usage rights for PDF files.

  Digital signing is supported only for PDF datasets created in Teamcenter 10.1 or later.

The DIGITAL_SIGN privilege lets users create an access control list (ACL) rule to digitally sign a PDF file and to cancel a digital signature.

The Digital Sign Dataset ACL rule grants the owning user and owning group digital signing privileges for the dataset object.

- World access users do not have digitally sign privileges.

  Note: The Digital Sign Dataset ACL rule may not be present in an upgraded system. To use the digital signature capability, this rule must be created.
• Sign a PDF file by choosing the rich client File→Sign command or the thin client Tools→Sign command.
  o The signed PDF file updates the PDF file stored in Teamcenter.
  o To cancel a sign action, choose the Cancel Signing menu command.

Siemens PLM Software recommends these methods for signing Teamcenter PDF documents:

• Sign documents with no markup.

  [Note] If you sign documents containing markups, those markups are embedded in the signed PDF file.

The initial configuration for digital signing of PDF files is set to not include markups as follows:

• The Sign action should be performed:
  o Per user, one document at a time.
  o Only one signature per document.

  [Note] The initial configuration for digital signing of PDF files is set to not include markups by the Find0IncludeMarkupsWithSignedFile business object constant default value, DoNotIncludeMarkups.

  For more information about business object constants, see the Business Modeler IDE Guide.

Configuration preferences for application launch from Microsoft Office

The following preferences are provided to support digital signing:

• Excel_ViewMarkup_Launchable_TcTypes
  Defines the Teamcenter types that can be launched for view and markup from Microsoft Excel.

• Outlook_Sign_Launchable_TcTypes
  Defines the Teamcenter types that launch for a digital signature from Microsoft Outlook.

• Outlook_ViewMarkup_Launchable_TcTypes
  Defines the Teamcenter types that launch for view and markup from Microsoft Outlook.

• PowerPoint_ViewMarkup_Launchable_TcTypes
  Defines the Teamcenter types that launch for view and markup from Microsoft PowerPoint.

• Word_ViewMarkup_Launchable_TcTypes
Definitions the Teamcenter types that launch for view and markup from Microsoft Word.

For information about using preferences, see the Preferences and Environment Variables Reference.

**Import a sample document management template file**

Teamcenter does not provide commercial off-the-shelf (COTS) dispatcher service configurations or IRDCs. But you can import a sample template file that contains examples (docmgt_samples.xml). You can use these examples as the basis for your dispatcher service configurations and IRDCs.

1. Install sample files (if not already done during standard installation).
   a. Start Teamcenter Environment Manager (TEM).
   b. In the Maintenance panel, select Configuration Manager and click Next.
   c. In the Configuration Maintenance panel, select Perform maintenance on an existing configuration and click Next.
   d. In the Configuration panel, select the configuration from which the corporate server was installed. Click Next.
   e. In the Feature Maintenance panel, under the Teamcenter section, select Add/Remove Features. Click Next.
   f. In the Features panel, under Server Enhancements, select Sample files.
   g. Click Next.
   h. In the Confirmation panel, click Next.
      The sample docmgt_samples.xml file is placed at the following location:

      server-install-location\sample\document_management

   i. Copy the document_management folder to another location where it can be referenced by the Business Modeler IDE.

      **Note** For more information about the sample files, see the readme file at the following location:

      server-install-location\sample\document_management

2. Open the docmgt_samples.xml file and use search and replace to change the prefix of SAM9 on the data model items to your own organization's prefix.

   **Note** When you name a new data model object, a prefix from the template is automatically affixed to the name to designate the object as belonging to your organization, for example, A4_.

3. Import the docmgt_samples.xml sample file into the Business Modeler IDE.
   a. Choose File→Import.
Chapter 3  Installing and configuring document management

The Import wizard runs.

b. In the Select dialog box, choose Business Modeler IDE→Import template file. Click Next.

c. Click the arrow in the Project box to select the project you want to import the sample file into.

d. Click the Browse button to the right of the Template file box and browse to the directory where the docmgt_samples.xml file is located, and select the docmgt_samples.xml file.

e. Click the arrow in the Extension file box and choose the extension file you want to receive the document management data model (for example, default.xml).

f. Click Finish.

The data model is imported from the docmgt_samples.xml file to the extension file in the project.

4. In the Extensions folder, open the Document Management folder to see the sample dispatcher service configurations and IRDCs. You can use these as the basis for your own dispatcher service configurations and IRDCs.

5. Deploy your template to a test server:

   Note After deployment of IRDC rules you may need to restart TAO services to ensure they are available to new tceserver processes.

6. Perform the following steps to import the DMTemplates file using My Teamcenter in the rich client:

   a. Choose Tools→Import→From PLMXML.

   b. Click the browse button (...) to the right of the Importing XML File box and select the following file:

   server-install-location\sample\document_management\importdmtemplates\DMTemplates.xml

   c. Leave the Transfer Mode Name set to the default value of ConfiguredDataImportDefault.

   d. Click OK.

   e. Perform the following steps to verify that the import worked:

      A. Choose File→New→Item, select Document in the New Item dialog box, and click Next.

      B. In the Additional item revision information panel, select Functional Specification in the Document Subject box.

      C. Verify that the document revision is created successfully and the correct sample functional specification Word dataset is attached to the newly created document revision.
D. Create another document and select the **Software Design Document** value in the **Document Subject** box. Verify that the document revision is created successfully and the correct sample software design document Word dataset is attached to the newly created document revision.

**Note** For more information about working with document management and the sample document management template file, see the *Business Modeler IDE Guide*. 
Chapter

4 Basic tasks for document management

Basic user tasks for document management ........................................... 4-1
Creating document templates ................................................................. 4-1
Creating documents .................................................................................. 4-1
  Rendering documents .............................................................................. 4-2
Generating thumbnail graphics ................................................................. 4-2
  Supported source and thumbnail file types ............................................ 4-3
  Viewing thumbnails ................................................................................. 4-4
Using full-text searches ............................................................................ 4-4
Using document management batch printing .......................................... 4-5
  Using the Batch Print dialog box ............................................................. 4-5
Configuring view and markup functionality .............................................. 4-7
Workflow and document management ....................................................... 4-8
Change management and document management .................................... 4-9
Basic user tasks for document management

Document management tasks include:

- Creating and maintaining document templates available to Teamcenter users.
- Creating documents based on IRDC control.
- Rendering documents manually, in workflows, and at checkin.
- Finding documents using full-text searches.
- Generating thumbnails.
- Printing documents.
- Using view and markup capabilities.
- Using documents in change management.

Creating document templates

An administrator can create template dataset files in an authoring application, and these files are associated with document template type objects and revision controlled in the same way as other items.

- Based on an item revision configuration definition (IRDC) object, a template can be associated with a specified document type to provide properties for the item revision when it is created.

- When a user creates a document of a type controlled by an IRDC object, the document management system creates source data based on the template assigned to the type. The user can then open the document source files in the appropriate authoring application and add content.

Creating documents

A document is a subtype of a Teamcenter item that represents all revisions of a real-world document. This item type supports documentation for products, processes, standards, and other aspects of a business, typically from applications.
such as Microsoft Word, Microsoft Excel, and so on. When you create a document, you typically begin in the My Teamcenter application.

Depending on how document types are configured at your site, you can create documents with or without the benefits of item revision definition control (IRDC) objects, which the site administrator configures to provide consistency in document behavior.

**Note** IRDC objects define how item revisions are handled at specific times in the life cycle, such as at item creation, checkin, checkout, save as, and revise.

### Rendering documents

You can render an item revision containing a dataset to translate the associated file to an alternate format. This results in a derived dataset file translated from the source dataset. For example, you can render an item revision with an attached Microsoft Office dataset file to add a derived Adobe PDF dataset file.

- An administrator configures item revision definition configuration (IRDC) and dispatcher service configuration objects to render an item revision.

- You render presentation versions of documents using menu commands, IRDC-specified actions, or workflow handlers. The IRDC objects let administrators specify actions that cause rendering, and also specify markup and print behavior.

**Note** To render item revisions under IRDC control, an administrator must configure IRDC and dispatcher service configuration objects to translate data. The parameters specified in the IRDC and dispatcher service configuration object determine the output type such as PDF.

For more information about configuring IRDC objects to render item revisions, see the *Business Modeler IDE Guide*.

For information about rendering document in the rich client, see the *My Teamcenter Guide*.

### Generating thumbnail graphics

The following events can generate thumbnail graphics, based on the item type configuration.

**Note** After any of the following events, you must do an explicit checkin of the item revision to generate thumbnails.

- Item create

  During item creation, attach an image file to the item.

  For more information about creating items in the rich client, see the *My Teamcenter Guide*.

  Explicit checkin is not required as an automatic checkin occurs during item creation.
• Update thumbnails
  Update Thumbnail functionality allows you to change the source dataset of the
  thumbnail and remove thumbnails from the item revision.
  You must perform an explicit checkout and checkin after this action.
  For more information about updating thumbnails in the rich client, see the My
  Teamcenter Guide.

• Update named reference of datasets
  You must perform an explicit checkout and checkin after this action.
  For more information about explicit checkout and checkin in the rich client, see the My
  Teamcenter Guide.

• Associate datasets containing named references to item revisions
  Datasets have different types of associated files. These files are the named
  references of the dataset.
  Associate a dataset to an item revision by creating a dataset under an item
  revision or by pasting another dataset to the item revision.
  You must perform an explicit checkout and checkin after this action.
  For more information about creating datasets in the rich client, see the My
  Teamcenter Guide.

• Associate item revision containing image file to another item revision
  o  Associate an item revision to another by pasting the item revision under
     another item revision.

  o  Explicit checkin is not required as the item revision being associated already
     has a thumbnail.

• Revise, Save As commands
  The File→Revise and the File→Save As commands generate thumbnails.
  You must perform an explicit checkout and checkin after this action.

Supported source and thumbnail file types
The following file types are supported as thumbnail source and output.

<table>
<thead>
<tr>
<th>Source file type</th>
<th>Thumbnail file type</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIF</td>
<td>JPEG, BMP, PNG</td>
</tr>
<tr>
<td>JPEG</td>
<td>JPEG, BMP, PNG</td>
</tr>
<tr>
<td>PDF</td>
<td>JPEG, BMP, PNG</td>
</tr>
<tr>
<td>AI</td>
<td>JPEG, BMP, PNG</td>
</tr>
<tr>
<td>JT</td>
<td>JPEG</td>
</tr>
<tr>
<td>EPS</td>
<td>JPEG, BMP, PNG</td>
</tr>
</tbody>
</table>
Using full-text searches

When the Autonomy search engine is installed and configured at your site, you can perform full-text searches on dataset files.

Full-text searches can be combined with searches for metadata, allowing you to search for datasets by attribute value as well as searching dataset files by keyword. For example, you can search for all documents containing the keyword cat that belong to owning user jsmith and have been modified after December 1, 2007.

- Wildcards can be used when performing keyword searches; however, partial keywords without wildcard characters cannot be used.

- If realtime indexing is enabled, the full-text search index is updated automatically whenever objects or their named references are saved, modified, or deleted.

Realtime indexing is enabled using the TC_fts_real_time_indexing preference. Objects subject to realtime indexing are specified by the TC_fts_indexed_types preference.

For more information about managing options and preferences, see Getting Started with Teamcenter.

An administrator can use the build_fts_index utility to build keyword indexes for the Autonomy search engine on an object-by-object basis for both the properties of dataset objects and the contents of dataset files.

For more information about configuring full-text search, see the Application Administration Guide.

For information about installing the full-text search engine as a Teamcenter feature, see the appropriate server installation guide (for Windows or UNIX/Linux) and the Teamcenter Environment Manager Help.

For information about working with preferences, see the Preferences and Environment Variables Reference.
For information about using utilities, see the *Utilities Reference*.
For information about performing specific types of full text searches in the rich client, see the *Rich Client Interface Guide*.

**Using document management batch printing**

Teamcenter document management batch printing lets you print documents without opening in an editor or viewer application, with support for:

- Multiple simultaneous document print requests.
- Specified default printer and a range of commercial printers and plotters.
- Data formats output and translated to printer formats.
- Asynchronous processing of printer requests.
- System-wide stamps and watermarks.
- User-specified stamps.
- Customizable banner pages.

**Note**

For information about creating print configurations, see the *Business Modeler IDE Guide*.

For information about using batch printing for documents in the rich client, see the *My Teamcenter Guide*.

For information about using batch printing for documents in the thin client, see the *Thin Client Interface Guide*.

**Using the Batch Print dialog box**

Batch printing is available in the My Teamcenter application in the rich client and the thin client.

The *Batch Print* dialog box provides the following options:

- **Print Configuration**
  Displays available print configuration objects.
  For information about creating print configurations, see the *Business Modeler IDE Guide*.

- **Printer Name**
  Displays the name of the printer specified by the selected print configuration.

- **Number of Copies**
  Specifies the number of copies to print. This field requires a positive integer between 1 and 99.

- **Collate**
When two or more copies are printed, this checkbox specifies whether the printed pages are collated.

- **User Stamp**
  Specifies text for a user stamp to be applied in addition to any existing system stamp configuration.
  For more information about creating system stamp configurations, see the *Business Modeler IDE Guide*.

- **Paper Size**
  Lists available paper sizes as provided by the selected print configuration object.

- **Page Range**
  Specifies a range of pages to print.

- **Color**
  Specifies *Color* or *Monochrome* printing.

- **Print To Scale**
  Specifies the scaling factor, from 0.000001 to 100.0, applied to an image when it’s printed.
  With standard fit-to-page functionality, the image size is adjusted to fit the paper.
  When *Print To Scale* is used, the image is adjusted to the scale value.

  - A value of 1.0 means the image prints at a 1:1 scale factor. For example, a square image that measures 5 inches on each side is printed 5 inches per side on the paper, regardless of the paper size. If the paper size is smaller than 5 inches, the image is cropped.

  - A value of 2.0 means the image prints at a 2:1 scale factor. In this case, a square image that measures 5 inches on each side is printed as a 10 inch image and cropped to fit the paper, if necessary.

  - A value of 0.5 reduces the printed image size, so the image that measures 5 inches on each side is printed at 2.5 inches per side.

- **Print Stamp**
  Provides a list to specify whether the print stamp applies to the first page, the banner page, or all pages.

- **Orientation**
  Specifies the paper orientation of best fit, portrait or landscape.

  - **Best Fit**
    The image is rotated 90 degrees, if necessary, so the long side of the image matches the long side of the paper.

  - **Portrait**
    No rotation is performed.
• **Landscape**
  By default, the image is rotated left 90 degrees.
  
  **Note**  Default rotation direction can be configured in Vis Print.

• **Banner Page**
  Specifies whether to print a page including the defined stamps and listing additional data as specified by the `vvcp` setup. The **Banner Page** box that has the following values: **Off**, **Single**, and **All Files**.

### Configuring view and markup functionality

View and markup configuration depends on tool object attribute settings and access privileges or roles.

**Note**  The `TCViewMarkupApplicationPref` site preference sets the preferred tools as **PDF_Tool** (configured for viewing using Adobe Reader) and **MSWord**. Use this preference for the **View/Markup** tool.

Several markup roles are available by default. Your Teamcenter administrator may have configured additional roles.

If you install Acrobat and create an **Acrobat Markup Tool** using Business Modeler IDE, you can launch Acrobat to do markups.

- An administrator can set the site preference using the rich client **Edit→Options** menu command.

- Users can create user setting that takes precedence over the site setting. For example, your **Acrobat Markup Tool, PDF_Tool, and MSWord** specifies using Acrobat, then Reader, then MSWord, in that order.

For more information, see the **Preferences and Environment Variables Reference**.

When markup capabilities are enabled and the user has markup privilege, the user can:

- Create new markups in the markup application.

- Save markups in Teamcenter from the markup application.

- Update the status field of a markup dataset with any text string. The value is typically **open**, **approve**, or **close**.

- Change the access control on the markups.

  For a markup dataset, in the **Properties** dialog box **Markup Access Control** field, you can specify:

- **PrivateMarkup** for private markups

- **GeneralMarkup** for general markups
In the Properties dialog box, to enable or disable official markup processing, select True or False for the Markup Official? value.

For more information about access control on markups, see Setting access privileges for markups.

**Note** For view and markup of item, item revision, or dataset objects with PDF files:

- The Teamcenter rich client and thin client View/Markup menu command launches either Acrobat or the Reader application with the appropriate plugin, based on the tool setup, and determines whether the user has permission to perform markup of the PDF.

- If the user has markup permission, the markup application Save menu command and the Comment menu command available.

  When the Save command is used, markups are saved to a Adobe Forms Data Format (FDF) file. The resulting new or updated FDF file is uploaded to Teamcenter.

- This functionality requires Acrobat 9 or later. Adobe Reader can also be used if the PDF file is Adobe Reader-enabled.

**Caution** Document management markup does not support multiple references in a dataset. Attempts to create markups in such cases can produce unpredictable results.

For information about viewing and marking up documents in the rich client, see the My Teamcenter Guide.

For information about viewing and marking up documents in the thin client, see the Thin Client Interface Guide.

For information about viewing and marking up documents in the Teamcenter Client for Microsoft Office, see the Client for Microsoft Office Guide.

**Workflow and document management**

Use the DOCMG-T-render-document-revision workflow action handler to render item revisions under IRDC control using a workflow.

For information about using the DOCMG-T-render-document-revision workflow action handler to render item revisions, see the Workflow Designer Guide.

For information about rendering an item using a workflow in the rich client, see the My Teamcenter Guide.
To render item revisions under IRDC control during a workflow, an administrator must configure an IRDC object to translate data during a task in the workflow.

To manage render validation and errors in workflows, insert a Validate task before the Do task for the render action handler, and then define a failure path. The render action handler may return failure states when the targets of the workflow are not configured to be rendered. The workflow designer determines how to respond to such events.

For information about using the Validate task, see the Workflow Designer Guide.

For information about configuring IRDC objects to render item revisions, see the Business Modeler IDE Guide.

Change management and document management

Change Manager helps you track changes to a product throughout its life cycle. You propose a change to a product and then manage the entire cycle of review, approval, and implementation of the change. This enables your organization to continuously improve its products by building them according to released documents, and then creating, changing, and approving the documents to build in continuous improvement.

Change Manager document items can be configured to use document management functionality. For example, typical item types supported for view and markup in context of a change include:

- Impacted item
- Implements item
- Plan item
- Problem item
- Reference item
- Solution item

Each of these can be managed by templates, supported with print stamps and watermarks in print manager, and routed through workflows in which users can mark up change items.

The Fnd0MarkupControlObjRels and Fnd0MarkupControlObject business object constants define which objects are consider context objects when the IRDC limits markup in a context of a change objects.

For more information about setting behavior with business object constants, see the Business Modeler IDE Guide.

For more information about using Change Manager, see the Change Manager Guide.
Chapter

5 Document management in Teamcenter clients

Document management in Teamcenter clients ........................................ 5-1
Rich client document management ....................................................... 5-1
Thin client document management ....................................................... 5-1
Teamcenter Client for Microsoft Office and document management ........ 5-2
Chapter 5  Document management in Teamcenter clients

Document management in Teamcenter clients

Document management functionality is available in the rich client, the thin client, and in Teamcenter Client for Microsoft Office.

Rich client document management

Users can perform document management tasks in the rich client.

These tasks include:

• Downloading files during checkout.
• Uploading files during checkin.
• Creating document templates.
• Creating documents and (optionally) attaching dataset files and submitting to a workflow during the create action.
• Rendering documents.
• Performing view or markup on documents.
• Digitally signing PDF datasets.
• Using batch printing capabilities.
• Generating thumbnail graphics.

For information about managing document behavior in the rich client, see the My Teamcenter Guide.

Thin client document management

Users can perform many document management tasks in the thin client.

These tasks include:

• Creating document items and (optionally) attaching dataset files and submitting to a workflow during the create action.
• Automatically rendering documents after checkin.
• Performing markup on documents.
• Digitally signing PDF datasets.
• Using batch printing capabilities.

For information about using document management and managing basic data in the thin client, see the *Thin Client Interface Guide*.

**Teamcenter Client for Microsoft Office and document management**

Teamcenter Client for Microsoft Office (Client for Office) uses document management functionality without requiring the user to exit Client for Office or to use another Teamcenter client.

Common tasks include the following:

• Creating and revising Teamcenter documents, datasets, and items.
• Checking documents out of and into Teamcenter.
• Inserting Teamcenter object data, such as property values, in documents.
• Handling your Teamcenter workflow.
• Performing view and markup actions for PDF and Microsoft Office dataset files.

You can mark up Microsoft Word documents with comments, loading markup into Teamcenter workflows, adding disposition comments to markups, and generating markup reports.

**Caution**

- When a base document is protected, markup comments are hidden and cannot be deleted.
- Loading hidden markup causes Microsoft Word to reassign comment numbers that do not reflect the actual comment sequence in the document. The correct comment numbers are restored when you close and reopen the document.

**Note**

Markup datasets cannot be displayed by expanding the source datasets in the Client for Office *Folder View*. Use the Teamcenter rich client to display markup datasets.

• Digitally signing a PDF dataset file.

In Microsoft Outlook, users can browse in Teamcenter to find a PDF file and then perform **Digital Sign**. This launches the Adobe Reader to display the PDF file for signing.

**Caution**

Do not close Outlook before saving the signed PDF file in Teamcenter.

For information about using document management in Teamcenter Client for Microsoft Office (Client for Office), see the *Client for Microsoft Office Guide*. 
Appendix

A  Glossary
Appendix

A Glossary

A

access control list (ACL)
Access Manager component that contains a list of accessors and, for each accessor, the privileges granted, denied, and not set.

Access Manager (AM)
Teamcenter application that enables the system administrator to grant users access to Teamcenter objects.

ACL
See access control list (ACL).

action handler
Handler used to extend and customize workflow task actions. Action handlers perform such actions as displaying information, retrieving the results of previous tasks (inherit), notifying users, setting object protections, and launching applications. See also task handler.

activity (manufacturing)
Individual action to be performed within an operation. Each activity is associated with a start time and duration. The total time for the operation is based on the cumulative duration of all activities within the operation.

Activities can be sequenced using time data and predecessor activities.

ad hoc process modification
Functionality that allows users to add tasks to, or delete tasks from, an active workflow process.

application
Related functional elements collected and arranged in a software package, designed to accomplish specified tasks. See also perspective.

approver
User who has a signoff in a workflow process regardless of role and group membership. In Access Manager, the approver accessor is used to allocate privileges that apply to all signoffs (for example, read access). See also RIG approver, role approver, and group approver.

attribute
Named storage variable that describes an object and is stored with the object. Users can search the database for objects using object attributes.

In an object, an attribute is a name/value pair; in the database, an attribute is a field.
Appendix A  Glossary

B

bulk data
Physical information represented in the database by a data item. Examples of bulk data are file system items, paper documents, and microfiche. The Teamcenter database describes the bulk data. The bulk data resides elsewhere, for example, in a file system or in a filing cabinet. See also data item.

business context
Context that defines the user groups to whom a rule applies.

Business Modeler IDE
Teamcenter application that enables a customer to define data model objects such as business objects, classes, attributes, lists of values, and rules.

business object
Logical grouping of data attributes and properties that are manipulated at the enterprise level.

A Global Services business object allows users to query for and update information in multiple data sources.

C

CGM
Computer Graphics Metafile (CGM) is a file format for 2D vector graphics, raster graphics, and text.

change
Temporary or permanent change to a configuration, design requirement, or documentation.

class
Set of objects that share the same list of attributes but distinguishable by the value the attributes acquire for specific objects. For example, the Automobile class can be defined by the brand, color, and price, but each car associated to the Automobile class has a different brand, color, and price combination.

class hierarchy
Structure defining subclasses that inherit the attributes of their superclasses, also called their parents or ancestors.

Classification
Teamcenter application that utilizes a classification hierarchy to categorize product data.

client
Role played by a software component of a system when it requests particular services be performed on its behalf by another entity, a server. See also server.

condition
Conditional statement that resolves to true or false based on the evaluation of an expression.
**Content Management**
Teamcenter application that enables users to manage SGML and XML information stored in a Teamcenter database and publish documents in multiple formats using SGML/XML editing and publishing tools. Content Management is used to collect and publish content, storing the content as components that can be reused in multiple publications, while links are maintained between components. The application includes processes for structuring publications so that they can be stored, published, and used for different purposes. Content Management also stores and manages graphics for use in publications, provides content revision control, and can incorporate Teamcenter workflows to facilitate the content development process.

**D**

**data item**
Teamcenter object representing bulk data defined and manipulated by application products, for example, papers that reside in a filing cabinet, directories and files that reside in a file system, Microsoft Excel spreadsheets, and CAD model and drawing files. Metadata for the data item resides in the Teamcenter database. See also *bulk data* and *metadata*.

**data model**
Abstract model that describes how data is represented and used.

**dataset**
Teamcenter workspace object used to manage data files created by other software applications. Each dataset can manage multiple operating system files, and each dataset references a dataset tool object and a dataset business object.

**dataset business object**
Teamcenter object that contains a list of tools that can operate on a dataset.

**dataset tool**
Teamcenter object that is the tool used to create or modify a dataset.

**deep copy rule**
Business rule that defines whether relational type objects can be copied as object, copied as reference, or not copied when the user performs a save-as or revise operation.

**derived visualization data**
File objects created by translating source data to other formats to support actions such as viewing and markups. Also called presentation data and neutral data. For example:

- An item revision with a Microsoft Word dataset is rendered and the Microsoft Word dataset file is translated to a PDF file.

- A large image is rendered as a thumbnail image.

- An NX PRT file is translated and rendered as a JT file.

See *translate* and *render*. 
digitally sign
Teamcenter action that lets you add your digital signature to an electronic document using third-party software, for example, Adobe Acrobat/Reader for an Adobe Portable Document Format (PDF) file.

digital signature
Electronic signature used to authenticate the identity of a document signer. The digital signature ensures that the content of the document is unchanged after the signature is applied.

Dispatcher service configuration
Object that defines the visualization file format that a dataset file is translated into.

document
Subtype of an item that represents all revisions of a real-world document. This item type supports documentation for products, processes, standards, and other aspects of a business, typically from applications such as Microsoft Word, Microsoft Excel, and so on.

document management
Management of real-world documents through the use of item revision definition configuration (IRDC) objects to configure document management behavior. IRDC simplifies user interaction with information and reduces the need for users to understand the Teamcenter data model and relationship model. See also item revision definition configuration (IRDC) objects.

E

enterprise tier
Teamcenter architectural tier that comprises a configurable pool of Teamcenter C++ server processes and a server manager. Larger sites can distribute the pool of server processes across multiple hosts. Smaller sites can run the pool of servers on the same host as the Web tier.

envelope
Teamcenter workspace object that represents a mail message sent by a Teamcenter user. Envelopes can be used to send workspace object references as well as text messages.

environment variables script
Teamcenter script (tc_profilevars) that sets variables for the Teamcenter environment. This script sets all Teamcenter environment variables except TC_ROOT and TC_DATA.

F

folder
Graphical representation of an aggregation of objects, such as a group, class, or subclass. For easy distinction in the class hierarchy, each of these aggregations has a different type of folder icon associated with it: a group folder icon, a class folder icon, or a subclass folder icon.
form
Teamcenter workspace object used to display product information (properties) in a predefined template. Forms are often used to create an electronic facsimile of a hardcopy form in Teamcenter. See also *master form*.

form type
Special type of the general POM Form class, which can have its own set of properties (attributes) associated.

four-tier architecture
Teamcenter architecture that includes four tiers: resource tier, client tier, Web tier, and enterprise tier. Contrast with *two-tier architecture*.

G

**group (Organization)**
Organizational grouping of users at a site. Users can belong to multiple groups and must be assigned to a default group.

**group administrator**
User with special maintenance privileges for a group.

**group approver**
User who is a signoff in a workflow process with a specific group of users. In Access Manager, the group approver accessor is used in Workflow ACLs and matches the signoff definition (that is, group) for the release level associated with the Workflow ACL. The group approver accessor ensures that only signoffs are given privileges, not a user who matches the group. See also *approver*, *RIG approver*, and *role approver*.

**group preference**
Teamcenter preference applying to an entire group.

H

**hierarchy**
Structure in which each node can have only one parent but possibly multiple siblings and children.

I

**Ignore**
Copy action rule when using templates to create process structures. No action is taken to duplicate the object in the cloned structure.

**impacted item**
Item revision to be changed as a result of the change process. It may be a detailed part or an assembly. A release status is attached by the workflow process the change is put through.

**implements item**
Problem report that is addressed by a change request or a change request that is addressed by a change notice. They are stored in the *Implements* folder of the implementating object in Change Manager. For example, the change notice’s *Implements* folder contains the change request.
Integration Toolkit (ITK)
Set of software tools provided by Siemens PLM Software used to customize Teamcenter or to integrate third-party or user-developed applications with Teamcenter. The ITK is a set of C functions used directly by Teamcenter and NX.

IRDC
See item revision definition configuration (IRDC) objects.

item
Workspace object generally used to represent a product, part, or component. Items can contain other workspace objects including other items and object folders.

item relation
Description of an association between a Teamcenter item and a piece of information that describes or is related to the item.

item revision
Workspace object generally used to manage revisions to items.

item revision definition configuration (IRDC) objects
Objects that define how item revisions are handled at specific times in the life cycle, such as at item creation, checkin, checkout, save as, and revise. IRDC objects are defined in the Teamcenter Business Modeler IDE application. Any item can be associated with an IRDC. For example, IRDC objects typically support business processes by managing document checkin and checkout and by specifying rendering of visualization or markup versions from source datasets.

item revision relation
Description of an association between a Teamcenter item revision and a piece of information that describes or is related to the item revision.

L

link
Manifestation of a business object relation in an end-user interface.
A link can represent a defined business object relation or a direct URL link.

M

markup data
File objects containing annotations based on specific derived visualization data.

markup management
Part of document management concerned with creating and retaining annotations on presentation data.

master form
Teamcenter workspace object used to display product information (properties) in a predefined template. Master forms are used to display product information in a standardized format.

metadata
Object description in the Teamcenter database.
**My Teamcenter**
In the Teamcenter rich client and thin client, application that is the main access point for managing product information. My Teamcenter provides the functionality for creating objects in the Teamcenter database, querying the database for objects, checking in and checking out objects, and managing tasks. Users can also open objects, automatically launching the related application.

Each user has a personal My Teamcenter window that displays product information as graphical objects. Although users share product information across the enterprise, they organize this information individually in personal workspaces.

**N**

**navigation pane**
Rich client framework component that displays buttons of the applications available for use in the rich client. Clicking the application button launches the application.

**neutral data**
See *derived visualization data*.

**notification**
Object that informs users of important events associated with selected objects. Compare with *subscription (Schedule Manager, Service Scheduler)*.

**O**

**object-based protection**
Use of access control lists to create exceptions to rules-based protection on an object-by-object basis. Object access control lists are most useful for either granting wider access or limiting access to a specific object.

**objects**
Discrete logical groupings of metadata.

**option**
Attribute of an item revision with a set of allowed values (for example, engine: 1200, 1600). Options are used when specifying variant data to configure a variant of an assembly. Option names are unique within an item revision, but not within the database.

**Organization**
Teamcenter application that enables a system administrator to create and manage critical Teamcenter files and database entries. It is the point of access for creating a company's virtual organization and for performing system administration activities such as volume creation, maintenance, and site administration. Organization enables creation and management of person, user, role, and group definitions; definition of the hierarchical structure of the Teamcenter organization; management of data volumes; and establishment and maintenance of Teamcenter sites.

**organization tree**
Graphic display of the Teamcenter organization structure. Expanding and collapsing branches of the tree enables viewing and managing the organizational structure. Selecting a node starts Organization wizards used to create groups, subgroups, roles, users, and persons.
Appendix A  Glossary

**owner**
User that owns an object, initially the user who created it. Ownership can be transferred from the owner to another user. An object owner usually has privileges that are not granted to other users (for example, the privilege to delete the object).

**owning group**
Group that owns an object, usually the group of the user creating the object. Because users commonly share data with other members of a group, additional privileges may be granted to the owning group (for example, the privilege to write to the object).

**P**

**part**
Business object type that can participate in a structure as an assembly or component, with or without attached datasets. In Teamcenter, a business item managed in a company's part releasing system. Typically, the assembly or component is designed and built by the OEM.

**part master**
Business logic entity containing data that applies to every instance of the part and part design, for example, weight or cost.

**person**
Definition containing real-world information about each Teamcenter user, such as name, address, and telephone number. Person definitions are stored as simple text strings so that they can be easily changed and updated. The name must be unique.

**perspective**
Container in the rich client user interface for a set of views and editors collected to accomplish specified tasks. See also view.

**plan item**
Schedule that defines tasks in a work breakdown structure.

**PLM XML**
Siemens PLM Software format for facilitating product life cycle interoperability using XML. PLM XML is open and based on standard W3C XML schemas. Representing a variety of product data both explicitly and via references, PLM XML provides a lightweight, extensible, and flexible mechanism for transporting high-content product data over the Internet.

**preference**
Configuration variable stored in a Teamcenter database and read when a Teamcenter session is initiated. Preferences allow administrators and users to configure many aspects of a session, such as user logon names and the columns displayed by default in a properties table.

**preference protection scope**
Hierarchical range for which a Teamcenter preference can be set. The protection scope of a hierarchical preference can be site, group, role, or user.

**presentation data**
See derived visualization data.
primary document
File object that does not rely on other documents and can be opened in an application such as Teamcenter lifecycle visualization or Adobe Acrobat. Also called a base document.

A primary document can have secondary types of documents that depend on it, such as markups or snapshots, but the primary document itself is not dependent upon any other file. Primary documents usually consist of one file, such as a PDF file or a logical set of files such as an assembly and parts.

privileged user (workflow)
Responsible party, process owner, or member of the system administration group. Privileged users have greater control over workflow tasks. For example, they can promote, demote, and skip workflow tasks.

privileges
Type and degree of access to data. Privileges can be granted to groups, roles, users, teams, and projects.

problem item
Item revision that the impacted item revision is replacing, typically the latest released revision of the impacted item. The problem item is compared with the impacted item to generate the changes (BOM change objects) when the edits to the impacted item are saved. This item is displayed in the Structure Manager right-hand pane to show removed components (highlighted in red).

product
Item or assembly (hierarchy of components and subassemblies) to be manufactured.

product data
Product definition data stored and managed by Teamcenter site, related descriptive metadata, and associated volume data existing at a site (owned or replicated). These data are commonly referred to as items in Teamcenter.

product lifecycle management (PLM)
Product lifecycle management (PLM) is an essential element in effectively creating and using global innovation networks to enable organizations and their partners to collaborate at every stage of the product life cycle. PLM provides businesses with unified information at every stage of the product life cycle including planning, development, execution, and support.

properties
Keys and values that specify the configuration settings for an application in the Teamcenter rich client.

properties file
File containing the attributes (keys and values) that specify how an application is to behave in the Teamcenter rich client.

property format finder (PFF)
Feature that allows you to gather and report data related to the objects returned by a query. PFF objects provide the necessary links and relationships required to locate arbitrary data without reformatting the query instance. PFF objects also enable you to acquire additional information that a single query would be incapable of rendering.
Appendix A  Glossary

**pseudofolder**
Special container in Teamcenter that stores and displays item and item revision relations in My Teamcenter. See also *smart folder*.

**Q**

**Query Builder**
Teamcenter application that enables a system administrator to create and maintain customized searches for objects in the Teamcenter databases, both local and remote. Saved queries are subject to standard object protection and can be accessed by users through the search feature in My Teamcenter.

**query form**
Predefined query used in My Teamcenter to quickly search the database without building a custom query. Query forms limit search criteria to boxes displayed in the form. Accessing additional search capabilities requires building a custom query.

**R**

**reference item**
Teamcenter object that contains information related to the problem report, change request, or change notice. For example, it can be an analysis document or system log. Any Teamcenter object, including a dataset, can be a reference item.

**relation**
Description of an association between a Teamcenter object and a piece of information that describes or is related to the object.

**release status**
Status associated with a workspace object when it is released through a workflow process.

**render**
Process that invokes the data translations specified for an item, such as a document revision, to generate derived visualization data. Translate is an action on a dataset. Render is an action taken on an object, such as a document. See also *translate*.

**resource**
Item used to perform an operation or define a process. Examples of resources include robots, tools, and machines. Both standard equipment and custom tools can be identified as resources.

**review task**
Task template that includes the *select-signoff-team* and *perform-signoffs* subtasks. Each subtask contains a unique dialog box for executing the process.

**rich client**
Java-based user interface to Teamcenter installed on user workstations. The rich client accesses Teamcenter databases using a remote or local server. Compare to *thin client*.

**rich client framework**
Component of the rich client that integrates and runs various applications from a common platform. These applications can be off-the-shelf applications such as NX CAD/CAM/CAE, Microsoft Office, custom applications, and Java plug-ins.
RIG approver
User who is a signoff in a workflow process with a specified role and group. In Access Manager, the RIG approver accessor is used in Workflow ACLs and matches the signoff definition (that is, role in group) for the release level associated with the Workflow ACL. This accessor ensures that only signoffs are given privileges, not a user who matches the role in group. See also approver, group approver, and role approver.

role
Function-oriented cluster of users that models skills and/or responsibilities. The same roles are typically found in many groups. In Access Manager, role is an accessor used to grant privileges to all users with the same skills and/or responsibilities regardless of project.

role approver
User who is a signoff in a workflow process with a specific role. In Access Manager, the role approver accessor is used in Workflow ACLs and matches the sign-off definition (that is, role in group) for the release level associated with the Workflow ACL. This accessor ensures that only signoffs are given privileges, not a user who matches the role. See also approver, group approver, and RIG approver.

role in group
Specific role in a specific group. In Access Manager, role in group is an accessor used to grant privileges to all users with the same skills and/or responsibilities in the same group.

role in owning group
Specific role in the object’s owning group. In Access Manager, role in owning group is an accessor used to grant privileges to users with the same skills and/or responsibilities on the same project. For example, all designers in the owning group are usually granted write privilege on their development data.

role preference
Teamcenter preference applying to an entire role.

rule handler
Handler used to integrate workflow business rules into Enterprise Process Modeling processes at the task level. Rule handlers attach conditions to an action. See also task handler.

rules-based protection
Conditions or rules that control who can or cannot access objects. These rules are global (that is, they affect the entire Teamcenter site) and are enforced by the Access Manager. These rules are defined by a system administrator.

rule tree
Access Manager component the system administrator uses to grant users access to Teamcenter objects. It is a tree of rules and access permissions that when processed determines the access that each user has to a specified object.
Appendix A  

Glossary

S

**secondary document**
File object that is meaningful only in the context of another document. Also called a derived document. For example, markup data and snapshot files can be viewed only in the context of a primary document, such as a JT file.

**serial number generator**
Number generator that can be configured on a neutral part to create serial numbers for every instance of a physical part. You can set characteristics for the serial numbers, such as a prefix, a suffix, the number increment, and the maximum number of characters in the serial number. During the instantiation of the physical structure from the neutral structure, you can choose to automatically assign the serial numbers to the newly created physical parts.

**server**
System software component that performs a specifically defined set of software services on behalf of one or more clients. In a typical Teamcenter installation, servers are centralized on dedicated hosts that support a large number of clients. Clients are distributed on hosts connected to the servers via various networking techniques. See also *client*.

**setup**
In a manufacturing environment, configuration of the work area. The setup also identifies the parts consumed and the resources used.

**Setup Wizard**
Teamcenter application that facilitates postinstallation setup of a Teamcenter database using an input file to populate the information required to create the basic components of the Teamcenter organization. Using Setup Wizard, a system administrator can create user/person definitions, assign a group/role to a user, and optionally define a default volume for assigned groups.

**Sign**
See *digitally sign*.

**site**
Individual installation of Teamcenter comprising a single Teamcenter database, all users accessing that database, and additional resources such as hardware, networking capabilities, and third-party software applications (tools) required to implement Teamcenter at that site.

**site preference**
Teamcenter preference that applies to the entire site.

**smart folder**
Pseudofolders configured in a hierarchical structure used to apply hierarchical levels of filtering to project data. See also *pseudofolder*.

**snapshot**
Folder that contains all the revisions of a configured product structure. A snapshot can be used to redisplay the as-saved structure.
Glossary

solution item
New item revision released with the change that has a release status attached. The item revision may be a new component part which replaces the old component in the parent impacted item. It may also be a new assembly that is being released.

source data
In document management and visualization, the original data format from which derived visualization data is produced, for example, a CAD assembly and part files, Word documents, and spreadsheet files.

status (workflow)
State applied to an object after it goes through a workflow. Typical statuses are Pending and Approved.

Structured Query Language
ANSI standard command and embedded language for manipulating data in a relational database.

subclass
In the Classification Search Dialog, subclass instances represent a subset of attributes corresponding to a class. Subclasses inherit the attributes of their parent classes. Unlike classes, which inherit every attribute of their parent classes and cannot be edited, users can define the inherited attributes assigned to a subclass.

subscription
Combination of a workspace object and an event for which a Teamcenter user requests notification of occurrence. Teamcenter notifies a subscribed user when the event occurs in association with the object. Users can subscribe to objects from Teamcenter applications, such as My Teamcenter and Structure Manager.

subscription (Schedule Manager, Service Scheduler)
Object that informs only the creator of the subscription when a specific task-related event occurs. Compare with notification.

T

task (workflow)
Fundamental building block used to construct a process. Each task defines a set of actions, rules, and resources used to accomplish that task.

task dependency
Link between two tasks creating an order of completion.

task handler
Small Integration Toolkit program or function. Handlers are the lowest level building blocks in Enterprise Process Modeling. They are used to extend and customize tasks. There are two kinds of handlers: action handlers and rule handlers. See also action handler and rule handler.

TC XML
XML format used to import and export Teamcenter data into and out of a Teamcenter site. For example, this format is required for Data Exchange transfers and allows mapping of objects between two sites that have different data models.
Teamcenter data directory
Directory location of the Teamcenter shared data subdirectories and files. The TC_DATA environment variable defines this location. Each data directory is associated with a single database instance.

Teamcenter Environment Manager (TEM)
Tool with a wizard-style interface that installs Teamcenter servers and two-tier and four-tier rich clients. TEM also performs maintenance operations, such as upgrading servers, applying maintenance patches, and installing patches. Teamcenter installers launch TEM using the tem.bat command (on Windows systems) or the tem.sh command (on UNIX or Linux systems).

Teamcenter location
Physical location that hosts a database and possibly other server-side components for one or more Teamcenter sites.

Teamcenter option
See preference and user preference.

Teamcenter Services
Set of services that allow customers to connect their applications to Teamcenter. Teamcenter Services use service-oriented architecture (SOA).

Teamcenter site
Teamcenter deployment that has its own server-side components, such as a database, volumes, and a corporate server.

TEM
See Teamcenter Environment Manager (TEM).

thin client
Teamcenter user interface that provides a streamlined browser-based view of product information stored in a Teamcenter database. The thin client is configured in the Web tier, which creates and serves its Web pages to the client. Compare to rich client.

translate
Process that converts data from one file format into another file format. In the context of Teamcenter document management, source data is converted to derived visualization data formats. The conversion is based on available translators. Translate is an action on a dataset. Render is an action taken on an object, such as a document. See render.

translation server
Web-accessible, scalable, and configurable software that performs translation from and to various file formats.

two-tier architecture
Teamcenter architecture that includes a resource tier and a client tier. The resource tier comprises the database server and database. The client tier comprises the Teamcenter rich client, third-party applications that integrate with the rich client, and a local server. This architecture supports only the Teamcenter rich client. Contrast with four-tier architecture.
Glossary

**U**

**user**
Definition that is the mechanism by which Teamcenter identifies and interacts with each user. User definitions contain a name (derived from the person definition), user ID, operating system name, and password.

**user preference**
Teamcenter preference applying to a specific user.

**V**

**value**
Content of a field or variable. It can refer to alphabetic, numeric, or alphanumeric data.

**view**
Software element in a rich client user interface perspective. It provides the ability to navigate hierarchies of information, display information about selected objects, open an editor, or display properties. See also *perspective*.

**visualization**
Ability to display a realistic, real time, graphical visualization of geometric data.

**W**

**Web tier**
Teamcenter architectural tier that comprises a Java application running in a Java 2 Enterprise Edition (J2EE) application server. The Web tier is responsible for communication between the client tier and enterprise tier.

**workflow**
Automation of the concept that all work flows through one or more business processes to accomplish an objective. Using workflow, documents, information, and tasks are passed between participants during the completion of a particular process.

**Workflows Designer**
Teamcenter application that enables administrators to graphically design workflow process templates, incorporating company business practices and procedures into the templates. Teamcenter users initiate workflow processes using these templates.

**Workflow Viewer**
Teamcenter application that enables users to view the progress of a workflow process. Users are not required to be participating members of the process being viewed. Depending on preference settings, Workflow Viewer also allows ad hoc process modification. See also *ad hoc process modification*.

**world**
All users regardless of group or role.

**X**

**XML object list**
Data Integration Services Adapter file that is formatted in XML and provides a list of the parts and assemblies to be populated into the JT cache.
# Index

## A
- Autonomy search engine ............... 3-3

## B
- BannerFormat ......................... 3-12
- BannerInfo .......................... 3-13
- Batch printing
  - Access privileges .................. 3-14
  - Banner pages ...................... 3-12
  - Configuring ....................... 3-11
  - Create MDS file ................... 3-13
  - File formats ...................... 3-14
  - MDS file .......................... 3-13
  - Prerequisites ..................... 3-11
  - Print configuration ................ 3-12
  - System stamp configuration ....... 3-12
- build_fts_index utility .......... 3-4, 4-4
- Business Modeler IDE
  - Working with ...................... 3-4

## C
- Change management .................... 4-9
- Client for Office .................... 5-2
- Configuring document management .... 1-2
- Configuring full text search ........ 3-3
- Content Management ................ 1-1
- Creating documents .................. 4-1

## D
- Dispatcher .......................... 3-3
- Document management
  - Basic concepts .................... 2-1
  - Basic tasks ........................ 4-1
  - Client for Office ................ 5-2
  - Creating documents ............... 4-1
  - Document behavior ................ 2-1
  - Examples .......................... 2-4
  - Functionality ..................... 1-1
  - Generating thumbnail graphics ... 4-2
  - Install and configure ............ 3-1
  - Prerequisites ..................... 3-1
  - Project .......................... 3-25
  - Rendering documents .............. 4-2

## E
- Enabling document management ....... 1-2
- Examples .......................... 2-4
- Excel_ViewMarkup_Launchable_TcTypes
  - preference ......................... 3-24

## F
- Full-text search ...................... 3-4, 4-4

## M
- Markup ................................ 4-7
  - Access privileges ................ 3-22
  - Client for Office ................ 5-2
  - Configure IRDC .................... 3-21
  - Configuring ....................... 3-21
  - Prerequisites ..................... 3-21
  - Update tool object ............... 3-21
- MetaDataStamp (MDS) file .......... 3-13

## O
- Outlook_Sign_Launchable_TcTypes
  - preference ......................... 3-24
- Outlook_ViewMarkup_Launchable_TcTypes
  - preference ......................... 3-24

## P
- PDF
  - Rendering ........................ 3-6
  - PowerPoint_ViewMarkup_Launchable
    - TcTypes preference ............... 3-24
  - Preferences
    - Excel_ViewMarkup_Launchable
      - TcTypes ......................... 3-24
    - Outlook_Sign_Launchable
      - TcTypes ........................ 3-24
    - Outlook_ViewMarkup_Launchable
      - TcTypes ......................... 3-24
    - PowerPoint_ViewMarkup_Launchable
      - TcTypes ......................... 3-24
Index

TC_fts_indexed_types .......................... 4-4
TC_fts_real_time_indexing .................. 4-4
Word_ViewMarkup_Launchable_TcTypes ... 3-24
Prerequisites ................................. 3-1
Prerequisites for document management ... 1-2
Printing ....................................... 4-5
Projects
  Document management ..................... 3-25

R
Render ......................................... 3-6
  Formats .................................. 3-7
  Output file types ....................... 3-8
  Prerequisites .......................... 3-6
  Thumbnail graphics ..................... 3-9
  Translators ................................ 3-7
Render Document command .................. 3-6
Rich client .................................. 5-1

S
Searching
  Full-text search ......................... 4-4
Start using document management ....... 1-2

T
TC_fts_indexed_types preference .......... 4-4
TC_fts_real_time_indexing preference .. 4-4
Teamcenter clients .......................... 5-1
Teamcenter Environment Manager ........ 3-3
Teamcenter Environment Manager (TEM) 3-3
TEM ........................................ 3-3
Thin client ................................ 5-1
Thumbnail graphics
  Generate .................................. 4-2
  prerequisites .......................... 3-10
  Rendering ................................ 3-9
Thumbnails
  Rendering ................................ 3-9
  Supported file types ................... 4-3
  View ..................................... 4-4
Translate .................................... 3-6

U
Utility
  build_fts_index ......................... 3-4, 4-4

V
vvcp.ini ...................................... 3-12

W
Word_ViewMarkup_Launchable_TcTypes
  preference .............................. 3-24
Workflow .................................. 4-8
  Markup, Client for Office .............. 5-2